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TIPS Carlson Software 2010 Installation Instructions 
 

Getting Started  
 
 All TIPS software users must install the latest KeyServer Client (i.e., version 6.x) on their 

machine prior to installing new software versions.  This is a requirement of the TIPS program to 
allow for adequate collection of license and server usage statistics. 
  
 The latest KeyServer Client is available on the TIPS website at 

http://www.tips.osmre.gov/tips_html/downloads.asp#K2. 
 

 Before starting the installation process, you will need the following: 
 

 TIPS Carlson Software 2010 CD or downloads from the Carlson website 
(http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fb
dfb&product=Carlson ). File: Full version Carlson 2010 dated 12/04/2009 or later. 

 AutoCAD Raster Design menu fix (i.e., cs10base.mnl) from TIPS Carlson Software 2010 
CD; if you do not have the CD please use TIPS contact(s) listed at bottom of this page. 

 Serial number, hosts file, and environment variable information provided with the OSM 
TIPS distribution. 

 The end user must have administrative privileges on the workstation for the software to 
function properly. 

 In order to avoid errors, the end user’s account should be logged in while performing the 
installation. 

 Approximately 15 minutes for installation on each user machine.  
 

General Overview  
 

In order to properly install Carlson Software 2010, you must do the following: 
 
1. Install and launch the Autodesk 2010 software prior to installing the Carlson product.  If 

Raster Design 2010 will be loaded on the user machine, it is required that it be installed and 
run once also prior to installing Carlson 2010. 

2. Use the instructions below to install Carlson Software 2010.  These instructions are based on 
installation onto AutoCAD Map 3D 2010 but can also be applied to installation on previous 
versions of AutoCAD Map. 

3.  Ensure that the environment variable LSHOST and the HOSTS file are set according to the 
documentation provided with the TIPS distribution notification.  Note that if a previous 
version of TIPS Carlson or SurvCADD software was installed, the required settings will have 
already been applied. 

4.  Launch Carlson Software 2010 in order to complete registration and automatically check for  
 and install current updates.  Current updates can be accessed directly at:    
 http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fbdfb
&product=Carlson. 

  
If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Mullins at (276) 523-
0042 x13 or TMULLINS@OSMRE.GOV. 
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Initialize Base Carlson 2010 Installation 
 
• If you have the TIPS Carlson Software 2010 disk, insert it into the appropriate drive.   If the 

installation does not start automatically, browse to and double click on the CD-ROM drive; if 
that fails to launch the installer, navigate to the root directory of the CD and double click 
‘Autorun.exe’.  Then click on Install Carlson 2010 to initialize. 
 

 
or 

• If you obtained the software via download, navigate to the location where the full version EXE 
file was saved and double-click on the file (i.e., Carlson2010.exe) to initialize the installation 
program. 
 

• The Carlson 2010 installation process will initialize… (Note: If the “Open File – Security 
Warning” window appears, click Run and continue.)  
 

 
 

• Click Next to continue with the installation. 
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• Review and, if agreeable, click Yes to accept the licensing agreement. 
 

 
 
• Select the version of CAD software that you want to use with Carlson 2010 (in this case, click on 

the circle next to AutoCAD / AutoCAD Map 2010). 
• Click Next to continue. 
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• Enter the Serial number provided with the distribution. 
• Click Next to continue. 

 

 
 
 

• Verify the install path.  The default ‘C:\Program Files\Carlson2010_ACAD10’ is recommended. 
• Use Browse to change the default location if desired. 
• Click Next to continue. 
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• Choose the preferred Setup Type: 
  ‘Complete Install’ copies all files to the user computer. 
  ‘Remote Install’ copies some files to the user computer and some to a network server. 
• The ‘Complete Install’ option is recommended (The ‘Remote Install’ option has not been tested 

and is not supported by TIPS.). 
• Click Next to continue. 
 

 
 

• Verify the Carlson work directory.  This is where the program will store drawing and data files 
by default.  The default ‘C:\Carlson Projects’ is recommended. 

• Use Browse to change the default location if desired. 
• Click Next to continue. 
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• Verify the project settings directory.  The default ‘C:\Carlson Projects\Settings’ is recommended. 
• Use Browse to change the default location if desired. 
• Click Next to continue. 

 

 
 

• Review the information in this dialog box to ensure that all settings are as desired.   
• If changes are needed, click Back to revert to the appropriate screen(s) and revise as necessary. 
• Click Next to continue. 
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• Enter an optional CAD profile if the user or your office has specified one. 
• The default (i.e., leave blank) is recommended. 
• Click Next to continue. 

 

 
 
 

• If a previous version of Carlson software is installed, you will see the following window. 
• Click ‘Yes’ (recommended) if the user wants program settings from the previous version applied 

to Carlson Software 2010. 
• Click ‘No’ if the user does not want the settings copied. 

 

 
 

• The installation will progress with files being copied… 
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• Select the version of the Autodesk product that you would like to start with Carlson 2010 (in this 

case, AutoCAD Map 3D 2010).  This is dependent on what version of Autodesk software is 
installed and was specified in the step at the bottom of page 3. 

• Click Next to continue. 
 

 
 

• The installation will continue with additional files being copied… 
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• Note Updates and Support options. 
• Click Next to continue. 

 

 
 

• Click Finish to complete the installation. 
 

 
 

 
• Before launching Carlson Software 2010, you must set the environment variable LSHOST and 

the HOSTS file according to the information provided with the TIPS distribution.  Note that if 
a previous version of TIPS Carlson or SurvCADD software was installed, the required settings 
will have already been applied. 
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Launch Carlson 2010 / Program Updates / Registration 
 

• Launch Carlson Software 2010 from one of the Carlson desktop shortcuts or from the MS 
Windows Start Menu. 

 

 
 

or 
 

 
 

• The program will automatically check for main program updates upon the first run (via internet 
connection). 

• If updates are identified during this process, it is recommended that they be installed to ensure 
that the most current features are available to users.  Simply follow the screen instructions to 
accomplish this. 

• If no updates are available (as shown below), click Exit. 
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• AutoCAD Map 2010 / Carlson Software 2010 will proceed to open. 
• If the AutoCAD Map 3D New Features Workshop box appears, select the circle next to ‘Maybe 

later’ to enable the user to be reminded of the New Features Workshop on the next program 
launch (The New Features Workshop can also be accessed at any time from the Map ‘Help’ 
menu.). 

• Click OK to continue. 
 

 
 
 

• The ‘Enter Carlson Software Serial Number’ window will appear if for some reason the Carlson 
registration process does not see the serial number entered during installation (page 4, above). If 
it does, enter the serial number provided with the distribution, and click on OK. 

 

 
 

• The Carlson registration process will complete. 
• Click OK to continue. 
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• The Carlson 2010 ‘Startup Wizard’ window will open as a default.  Click Exit to close the 

window and continue the software start-up. 
• Note: The ‘Startup Wizard’ will not appear if the user had previously altered this setting and the 

installation included copying the settings (see the middle of page 7, above).  
 

 
 

• Carlson 2010 will open to the module selected to initiate the program (in this case ‘Carlson Civil 
2010’). 

 

 
 

• Next, verify that Carlson 2010 is set to open to the ‘AutoCAD Map Classic’ menu. 
• Select the ‘Settings’ menu dropdown and click on Carlson Configure… 
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• Click General Settings… 

 

 
 

• Verify / select AutoCAD Map Classic as the setting for ‘AutoCAD Menu.’ 
• Click OK to continue. 

 

 
 

• Click Exit to close Carlson 2010 configuration. 
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Restore AutoCAD Express Tools and / or Raster Design Menus  
 

• Launching Carlson 2010 using the program ‘Start’ menu or desktop shortcuts may set AutoCAD 
with Carlson 2010 to open minus the ‘Express’ (i.e., Express Tools) and / or ‘Image’ (i.e., Raster 
Design) dropdown menus. 

• Once the menus are restored per the steps below, the settings will be preserved.  The ‘Express’ 
and ‘Image’ menus will be included no matter what program shortcuts or ‘Start’menu item is 
used to open AutoCAD Map / Carlson 2010. 

• Note:  The ‘Express’ and ‘Image’ menus may not appear in the same position or order as shown 
in the screen capture below. 

  

 
 

• To restore the ‘Express’ menu, simply enter ‘expresstools’ on the command line (i.e., type 
‘expresstools’ and press the enter/return key.). 

 

 
 

• If the AutoCAD Raster Design ‘Image’ menu dropdown (shown in the screen capture above) 
does not appear after Carlson software installation, a Carlson menu file must be 
updated/replaced. 

• Go to the ‘File’ menu dropdown and click Exit to close the program. 
• If you have the TIPS Carlson Software 2010 disk, open the disk and click on the ‘Raster Design 

Menu Fix’ button.   

 
 

• The ‘Image’ menu dropdown will be restored (Open the program once using the ‘Raster Design’ 
desktop shortcut or ‘Raster Design’ Windows Start Menu item.).   

• Click Finish to close the installation CD; this completes the installation of Carlson 2010.  
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• If you do not have the TIPS CD, contact Tom Mastaller at (412) 937-2108 / 
TMASTALLER@OSMRE.GOV or Tonya Mullins at (276) 523-0042 x13 / 
TMULLINS@OSMRE.GOV to obtain the ‘cs10base.mnl’ file. 

• Rename the existing ‘cs10base.mnl’ file located in the Carlson 2010 software ‘SupTemplate’ 
subdirectory  (e.g., C:\Program Files\Carlson2010_ACAD10\SupTemplate\cs10base.mnl) as 
‘cs10base.ORG’. 

• Copy the new ‘cs10base.mnl’ to the Carlson 2010 software ‘SupTemplate’ subdirectory (i.e., 
C:\Program Files\Carlson2010_ACAD10\SupTemplate\cs10base.mnl). 

• The ‘Image’ menu dropdown will be restored (Open the program once using the ‘Raster Design’ 
desktop shortcut or ‘Raster Design’ Windows Start Menu item.).   

• This completes the installation of Carlson 2010.  
 

Latest Program Version / Updates  
 
• The latest program full version and updates / patches can be accessed / downloaded at any time 

by visiting http://update.carlsonsw.com/updates.php; selecting the product ‘Carlson 
Survey/Civil/Mining/Takeoff for CAD’; clicking Show Files; and then selecting product version 
‘2010 for AutoCAD/IntelliCAD’. 

 

 
 

 
 
 
 
 
 
 

http://update.carlsonsw.com/updates.php�
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Checking and/or modifying your computer’s environment variables (for 
Windows): 
 
Occasionally, the environment variables are not set correctly to allow Carlson to obtain a license from 
the TIPS license server. Please check to see that your variables are set correctly following these steps. 
The variable information is contained within the software distribution letter mailed to your TIPS contact. 

 
1. Go to the Start Menu -> Control Panel -> System. The following dialog should appear 

(select the “Advanced” tab, as shown) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click on the “Environment Variables” button near the bottom. In the lower half of this 
dialog box is the area where you can add new variables (which should be done during 
installation), or modify the existing ones (if you are having problems). 

 
 
 
If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Mullins at (276) 523-0042 x13 
or TMULLINS@OSMRE.GOV.  
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